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File menu commands

The File menu offers the following commands:

Exit Exits WinWaste.



View menu commands

The View menu offers the following commands:

Status Bar Shows or hides the status bar.

Options menu commands

The Options menu offers the following commands, which enable you to customize WinWaste 
to your needs:

Warnings... Opens the Warning Options dialog box. You can enable or 
suppress WinWaste warnings.

Move Files... Opens the Move Files Dialog box. You can select backup 
options for removable media.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



Exit command (File menu)

Use this command to end your WinWaste session.    You can also use the Close command on 
the application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item, the idle state of the application, and keyboard latch 
state. A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the WinWaste window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.

The next area indicates whether the application is idle (empty area) or busy with file 
operations (Busy...).

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Warnings... command (Options menu)

Use this command to open the Warning Options dialog box. Click on any item of the dialog 
box below to get more information or read the description below the dialog box.

Deleting files group
Upon deleting files or directories, WinWaste may issue a warning in the following cases 
(check the ones you want):
 The subdirectory to be deleted is not empty (possible loss of files you're not aware of)
 The file to be deleted is a system file (possible system crash)
 The Delete All command will delete all files in the list (possible loss of more files than 
desired)

Moving files group
In certain cases (see Move files command), WinWaste will move a backup of discarded files 
from a removable medium like a floppy disk to the harddisk. Check this box if you want to be
warned before files are moved.

Trash full group
If you check this box, WinWaste will issue a warning after discarding a file if the trash can is 
full. You can specify what "full" actually means: Either you can limit the number of files, or 
you can limit the number of bytes. Thus you can control how much disk space should be 
used for discarded files. In any case, WinWaste will accept further discarded files up to the 
physical limit of 65535 files per directory. Remember that a subdirectory counts as 0 byte, 
regardless of how many bytes the files in that directory hold.



Move files command (Options menu)

Use this command to open the Move Files dialog box. Click on any item in the dialog box 
below to get more information or read the description below the dialog box.

Check the box on the left if you want to move backups of discarded files from removable 
media (like floppy disks or harddisk cartridges) to the harddisk. This is useful because 
discarding (in contrast to deleting) a file will not increase the available disk space as long as 
the backup remains in place.

You can further specify whether the backups are moved always or only if a certain amount of
floppy disk space is occupied. Thus you can free disk space if the floppy disk is nearly full, 
but leave the backups on the floppy (and thus save time) if enough disk space is available.

Use the listbox on the bottom to navigate through your file system and specify where the 
backups are to be moved to on your harddisk. You may wish to create a subdirectory in your 
WinWaste program directory for this purpose. Do not use a root directory like C:\, as the 
number of file entries in root directories, in contrast to subdirectories like C:\WWASTE1, is 
limited.



View File command (Button)

Use this button to view the contents of a single selected file. In all cases, WinWaste first 
restores the selected file before running or viewing it. 

 If the file is a program file, WinWaste starts this application. Be aware that many 
applications need more than one file for proper execution.

 If the file is a document, WinWaste starts the application which is associated with this type 
of document and loads the file. If the file is not known to be a document, you can use the 
Windows Notepad or any other viewer to view the contents of the restored file manually.

 If the file is a directory, use the Windows File Manager to view the contents of the restored 
directory.

Shortcut
Mouse: Double-click on the file in the listbox to view it.



Delete command (Button)

Use this command to delete the selected file or files (use the SHIFT key to select a range of 
adjacent files from the listbox or the CTRL key to select scattered files from the listbox). The 
files or directories will be deleted from the file system and can only be recovered by means 
of special tools like Undelete.

If you delete a directory, all files and subdirectories of this directory will be deleted as well. 
Switch on the "Subdir not empty" warning in the Warning Options dialog box to avoid 
accidental loss of files.

Shortcut
Keyboard: Press the "Del" key.



Delete All command (Button)

Use this command to delete all files in the listbox. The files or directories will be deleted 
from the file system and can only be recovered by means of special tools like Undelete.

This command can also be accessed in the iconized state via the Control menu (see Empty 
trash can).

If you delete directories, all files and subdirectories of these directories will be deleted as 
well. Switch on the "Subdir not empty" warning in the Warning Options dialog box to avoid 
accidental    loss of files.

To avoid accidental loss of all discarded files, switch on the "Delete All" warning in the 
Warning Options dialog box.



Restore Command (Button)

Use this command to restore the selected file or files (use the SHIFT key to select a range of 
adjacent files from the listbox or the CTRL key to select scattered files from the listbox). The 
files or directories will be visible again to all other Windows and DOS applications and will be
moved back to their origin, if neccessary.

In certain cases, it is not possible to restore a file at its origin:
 the source directory has been deleted or renamed
 the source floppy disk is currently not available
 a file with the same name has been created in the same directory

In these cases, a "Save as..." dialog box allows you to restore the file at a different location 
or with a different name.

Shortcut
Keyboard: Press the "Ins" key.



Restore All command (Button)

Use this command to restore all files in the listbox. The files or directories will be visible 
again to all other Windows and DOS applications and will be moved back to their origin, if 
neccessary. 

In certain cases, it is not possible to restore a file at its origin:
 the source directory has been deleted or renamed
 the source floppy disk is currently not available
 a file with the same name has been created in the same directory

In these cases, a "Save as..." dialog box allows you to restore the file at a different location 
or with a different name.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using WinWaste and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
WinWaste.



Always on top command (Control menu)

Select this command to let WinWaste float on top of all other applications even when it is not
the active window. When selected, a checkmark appears to the left of the menu command. 
This option is useful to let WinWaste float on top of the Windows File Manager when 
discarding files (it will not disappear behind the File Manager while you select files to 
discard).

The Control menu is accessible by clicking on the icon of the minimized application or by 
clicking on the upper left corner of the application window.



Empty trash can command (Control menu)

This command is the same as the Delete All button and will delete all files in the listbox. 

To avoid accidental loss of all discarded files, switch on the "Delete All" warning in the 
Warning Options dialog box.

The Control menu is accessible by clicking on the icon of the minimized application or by 
clicking on the upper left corner of the application window.



Overview

This section describes the basic features of WinWaste:

WinWaste is an easy-to-use trash can for files. Directories can be handled in the same way, 
as they are simply special files. Files can be discarded comfortably by means of the 
drag&drop feature of Windows 3.1. This works in the open and in the iconized state. The files
may be restored or deleted at a later time. You may even switch off your computer after 
discarding files and restore them in a later session.

When files are discarded, they are not actually deleted. WinWaste hides and renames them, 
so they are no longer visible to Windows and DOS applications. As the backup files still 
occupy disk space, it is useful to empty the trash can at regular intervalls. The Warnings... 
command offers the possibility to let WinWaste notify you as soon as a given disk space is 
occupied by discarded files. Additionally, the WinWaste title bar shows the number of 
discarded files in the open and iconized state.

The capacity of the trash can is quite large: Usually, the number of discarded items is limited
only by your harddisk or your RAM.

If you wish to discard files on a floppy disk, you usually want to free the disk space instantly. 
WinWaste features the Move Files option for this purpose. If you wish, WinWaste keeps a 
backup of the files on the harddisk and releases the disk space on the floppy instantly. You 
may later restore the discarded file again to the floppy disk or to any other drive.

The WinWaste window consists of the following areas:

Click on the items to get more information.



The listbox uses the following symbols to denote different file/directory types:

Any nonspecial file.

Any write-protected nonspecial file.

A document file.

A write-protected document file.

A subdirectory.

A system file.

An executable file.



How to... throw files into the trash can

Files and directories are thrown into the trash can ("discarded") by means of the drag&drop 
feature of the Windows File Manager. Select the files and directories with your mouse in the 
right pane of the File Manager (the left pane will not work), drag them over the WinWaste 
window or icon, and release the mouse button there. You can select and drop several files or 
directories in one operation.

The discarded files and directories are added to the head of WinWaste's listbox, so you will 
always find the most recently discarded files on top of the list. WinWaste's title bar, visible in
the open and iconized state, displays the number of files or directories which are currently 
discarded.

The files are not physically deleted. They still exist, but they are not visible to Windows or 
DOS applications. If your File Manager shows strange hidden files like "tr000000.trs" and you
prefer not to see them, deselect the "Show hidden/system files" checkbox in the Windows 
File Manager.



How to... get them out again

If you accidentally discarded a file which you still need (which may be obvious only after a 
while), you may get it back unless the trash can has already been emptied (see How to... get
rid of them).

If necessary, open the WinWaste window by double-clicking on the WinWaste icon. WinWaste
displays a list of all files which are currently discarded but not yet deleted. Select one or 
several files and directories with your mouse and then press the Restore button. If you want 
to restore all files in the list, press the Restore All button.



How to... get rid of them

If you keep on discarding files, the trash can becomes fuller and fuller. You will have to free 
disk space by actually deleting the discarded files. Be careful: Deleting means your files are 
gone forever (unless you use special tools).

If WinWaste is iconized, click on the icon to display the Control menu. Use the Empty trash 
can command to delete all discarded files.

You may also wish to delete only selected files or directories. If necessary, open the 
WinWaste window by double-clicking on the WinWaste icon. WinWaste displays a list of all 
files which are currently discarded but not yet deleted. Select one or several files and 
directories with your mouse and then press the Delete button. If you want to delete all files 
in the list, press the Delete All button.



Move files off removable media

This applies only to files on removable media like floppy disks. If this box is checked, 
WinWaste will keep the backup of the discarded file on the harddisk and release the disk 
space on the floppy instantly.



Always

This radio button is only available when the "Move files off removable media" box is 
checked. Check this button to let WinWaste move the backup of discarded files off the floppy
disk regardless of the disk space which is occupied on the floppy.



If more than XX% of disk space occupied

This radio button is only available when the "Move files off removable media" box is 
checked. Check this button to let WinWaste move the backup of discarded files off the floppy
disk only if more than XX% (enter a value between 0 and 100%) of the floppy disk space are 
currently occupied by files. That is, if a floppy is nearly full, the backups go to the harddisk, 
and floppy space is set free. If the floppy is nearly empty, the backups remain where they 
are, thus saving the time necessary to move the files.



Move to:

The backups of files, which are to be moved off a floppy disk, will be copied to this directory. 
You can select the directory in the listbox below this control.



Directory listbox

Use this listbox to set the "Move to" directory shown over the listbox. To navigate through 
your directory system, double-click on the entries in the listbox. [-X-] denotes the drives on 
your system; [..] denotes the parent directory of the current directory. All other entries are 
the available subdirectories.



OK

Click this button to close the dialog box and save the current settings.



Cancel

Click on this button to close the dialog box without saving any changes you've made.



Subdir not empty

If this box is checked, WinWaste will issue a warning whenever you attempt to delete a 
discarded subdirectory which contains at least one file or subdirectory. You may then click 
OK to delete the subdirectory and the files contained therein anyway or Cancel to view the 
contents of the subdirectory.



System file

If this box is checked, WinWaste will issue a warning if you attempt to delete a discarded 
system file. You may then either continue or cancel.



Delete all

If this box is checked, WinWaste will issue a warning whenever you attempt to delete all 
discarded files using the Delete all button or the Empty trash can control menu command. 
You may then click OK to delete the files anyway or Cancel to stop the operation.



Warn before moving files

If this box is checked, WinWaste will ask whether files should be moved off a floppy if you 
discard files on a floppy and the Move Files option is toggled on. You can either click Yes to 
move the files or NO to leave the discarded files at their origin or Cancel to stop the 
operation.



Warn if full

If this box is checked, WinWaste informs you that the trash can is full whenever you discard 
a file and the condition set in the controls below the check box is met.



If more than XX files

This radio button is only available when the "Warn if full" box is checked. Check this button 
to let WinWaste notify you when you discard a file and after the operation more than XX files
are discarded.



If more than XXXXX byte

This radio button is only available when the "Warn if full" box is checked. Check this button 
to let WinWaste notify you when you discard a file and after the operation more than XXXXX 
byte are discarded. Remember that discarded directories count as zero byte regardless of 
the size of the files in this directory.



OK

Click this button to close the dialog box and save the current settings.



Cancel

Click on this button to close the dialog box without saving any changes you've made.



Control menu button

Click on this button to open the application's control menu. Here you can access the Always 
on Top command and the Empty Trash Can command.

Double-click on this button to close the application.



Titlebar

As with any other Windows application, you can drag the WinWaste window around with your
mouse, holding the window at the titlebar.
WinWaste informs you about the number of currently discarded items.



Minimize button

Click on this button to minimize the WinWaste window (show it as the trash can icon).



Maximize button

Click on this button to show the WinWaste window at its maximum size, covering the whole 
screen. This may be convenient in cases when files with very long paths are discarded.



Files/Bytes discarded

Here you can see the number of discarded items and the number of byte that the discarded 
files hold. Remember that a discarded subdirectory counts as zero byte, irrespective of the 
size of the files which are contained in this directory.



File Listbox

This listbox shows the files and directories which are currently discarded. The paths are 
truncated to the drive. To see the full path of a file, click on this file and read the information 
at the lower part of the WinWaste screen.
If more files are discarded than the listbox can hold on the screen, a scrollbar appears to the 
right to let you scroll through the list. The most recently discarded files are always on top of 
the list.
As shown in the example, this is a multiple-selection listbox. You can mark several files by 
holding the Shift or the Ctrl key while you select.



File information field

Line 1 shows the full path of the currently selected file.
Line 2 shows the size of the currently selected file in byte. The size of subdirectories is 
always zero byte.
Line 3 shows the time and date the currently selected file was created.
Line 4 shows the time and the date the currently selected file was thrown into the trash can.



Status bar

Pane 1 explains the menu commands while you browse the menu.
Pane 2 switches to "Busy..." during long file operations.
Pane 3 shows the status of the Caps lock key.
Pane 4 shows the status of the Num lock key.
Pane 5 shows the status of the Scroll lock key.



Button field

These buttons let you handle your discarded files at a mouseclick. You can View a file, Delete
selected files, Delete all files, Restore selected files, or Restore all files.




